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 Introduction to SimApis 
A SimApi is a software interface between the Umetrics Suite software and a data source. The primary purpose of a SimApi is 

to provide data to SIMCA®-online, SIMCA®, or Easy Analytics from the data source. 

Sartorius Stedim Data Analytics develops SimApis for many different data sources, such as process historians and general purpose 

databases. 

This document shows what a SimApi is, and how it is used in Umetrics Suite products. You learn important technical aspects on 

SimApis, and finally installation and troubleshooting are described. 

1.1 A SimApi provides data for tags to Umetrics Suite 

products 
A SimApi exposes a hierarchy of nodes, corresponding to folders in a file system. Each 

node can contain other nodes, or tags. A tag corresponds to a variable. For these 

variables Umetrics Suite products can obtain data. The following pictures illustrates 

the process of selecting a tag from a data source.  

1.2 SimApi usage in the Umetrics Suite 
SIMCA can use a SimApi to retrieve data for project creation and model building as 

the following picture illustrates. 

Figure 1. SIMCA used to obtain data from a data source through a SimApi. Easy Analytics has a similar setup. 
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SIMCA-online use SimApis to obtain data in real-time for monitoring and control, as well as write back of data to the data source. The 

following picture shows where the SimApi is located in a system consisting of a data source, SIMCA-online server, and clients. 

1.3 Commonly used SimApis 
The SimApis often used by customers are: 

• PI. There are two SimApis: the PI Batch SimApi developed by OSIsoft, or the new PI AF SimApi developed by Sartorius. 

• ODBC - for general access to databases such as SQL Server or Oracle 

• OPC HDA  using the standard from the OPC Foundation 

We recommend that customers use one of these tried and tested SimApis that provides full functionality with SIMCA-online or 

SIMCA. 

The available SimApis are listed below in 3. 

1.4 The DBMaker SimApi for simulation data 
DBMaker is an application provided with the SIMCA-online server installation. It simulates a data source, such as a process historian, 

by using a preloaded data table with a number of observations which are provided one by one to SIMCA-online through the DBMaker 

SimApi. 

DBMaker is only used for demonstrational purpose data and cannot be used in production with real data from an external data 

source1. 

1.5 Other documenation 
The document you are reading now is one of a set of related documents, each with different focus and target audience. Refer to the 

below table to learn more. 

                                                                 
1 You can publish your own data with DBMaker for testing SIMCA-online. See the following knowledgebase article for more 

information: umetrics.com/kb/testing-simca-online-real-world-data-without-simapi  

Figure 2. A SIMCA-online installation with a server with SimApis connecting to data sources, and SIMCA-online clients working with data on the SIMCA-online 

server. 

http://umetrics.com/kb/testing-simca-online-real-world-data-without-simapi
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Source What Where 

Umetrics.com web site Introductory information, as well as downloads of most other 

documentation below 

umetrics.com  

SIMCA-online ReadMe 

and Installation.pdf 

Installation of SIMCA-online and how to quickly get started with 

demo data. 

In the installation zip file 

SIMCA-online 

Implementation Guide 

Outlines SIMCA-online functionality, puts it in context with 

other Umetrics Suite software, describes requirements and best 

practices for successful deployment, and step-by-step 

installation instructions. 

umetrics.com/download/online  

SimApi Planning and 

Installation Guide 

Preparing for and performing SimApi installations, including 

troubleshooting. 

umetrics.com/simapi  

SimApi User Guides One for each published SimApi. Lists the features, installation 

instructions, and configuration specifics of each individual 

SimApi. 

umetrics.com/simapi  

SIMCA-online 

Technical Guide 

Technical reference for SIMCA-online server installation 

planning, SimApi functionality, troubleshooting, and how 

SIMCA-online really works. 

umetrics.com/download/online  

SIMCA-online help How to use SIMCA-online and how SIMCA-online works. Less 

depth  than in the Technical Guide but with detailed user 

interface instructions. 

In the installation zip file, and 

in the software itself 

SIMCA-online Web 

Client User Guide 

Describes the features, installation, and usage of the optional 

SIMCA-online Web Client. 

umetrics.com/download/online  

Umetrics knowledge 

base 

Searchable database with articles about each released software 

version, technical articles, and known issues on Umetrics Suite 

products. 

umetrics.com/kb  

SIMCA help How to use SIMCA for creating projects.   

1.6 Technical support 
Sartorius Stedim Data Analytics online support team answers technical questions about SimApis, and can also forward requests for 

enhancement of SimApis to the appropriate people. umetrics.com/support 

The public SimApi specification for developers and a software development kit with sample code can be obtained from Sartorius 

Stedim Data Analytics by contacting your sales representative. 

 Obtaining SimApis 
Sartorius Stedim Data Analytics web site provides documentation for SimApis, and links to SimApis which are offered from partners. 

See umetrics.com/simapi. 

All SimApis built in-house can be aquired in the web shop on that page. SimApis are often included in maintenance agreemens for 

Umetrics Suite products. Talk to your Sartorius sales representative. 

Consult the feature matrix in the next chapter to learn more about SimApi functionality and which SimApis support which features.  

For details about a specific SimApi, see its User Guide. You should also download and read the SimApi Overview User Guide (this 

document) for SimApi planning, installation instructions and troubleshooting tips. 

https://umetrics.com/
htttps://umetrics.com/download/online
https://umetrics.com/simapi
https://umetrics.com/simapi
htttps://umetrics.com/download/online
htttps://umetrics.com/download/online
https://umetrics.com/kb
https://umetrics.com/support
https://umetrics.com/simapi
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 SimApi features 
Not all data sources are alike. A SimApi need not implement all functions in the specification. For these reasons, different SimApis 

offer different functionality. The following matrix lists available SimApis and their features. Individual features are explained below.  

The table below explains all features used in the above feature matrix. Notice that the table has separate columns to show which 

features are available in SIMCA-online and SIMCA/Easy Analytics respectively. 

Feature Purpose SIMCA-online usage SIMCA and Easy 

Analytics usage 

Current data Read the most recent value from the 

data source. 

Real-time normal execution  

Historical data Read historical data from the data 

source. 

Catch-up and repredict of past 

data, create projects using File > 

New 

Database Import 

Wizard to import 

process data for 

model creation. 

Discrete data Read laboratory/IPC data from the 

data source. Discrete data can be 

used for batch configurations when 

data needs to be re-read during the 

batch evolution. Many observations 

per batch. 

For batch projects with phases 

configured for discrete data 

retrieval. 
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Current data o o o o o o o o o o o o o

Historical continuous data o o o o o o o o o o o

Discrete data o o o

Batch data o o o o o o o o

Batch context node o o o o o o o o

Write back - continuous data o o o o o o o o

Write back - discrete data o o

Write back - batch data o o o o o

Node hierarchy o o o o

Array tag expansion o o o

Multiple data sources o o o o o o o

Connection resiliency o o o o o

Developed in-house o o o o o o o o o o o o
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Batch data Read batch conditions and final 

quality attributes (or other MES type 

data). One observation per batch. 

Batch conditions or local 

centering. 

Database Import 

Wizard to read 

batch conditions 

for batch level 

model creation. 

Batch node Specify the start time and the end 

time (empty for an active batch) for 

a specific batch. Enumerate all 

batches that existed in a time range. 

Required for execution of batch 

configurations. 

Database Import 

Wizard to select 

batches to import. 

Write back - 

continuous data 

Write continuous data, such as 

predictions, back to the data source. 

Write back for batch 

configurations for the batch 

evolution level or for continuous 

configurations 

 

Write back - 

discrete 

Write discrete data, such as 

predictions, back to the data source. 

Write back for batch 

configurations at the batch 

evolution level for phases 

configured for discrete data 

retrieval 

 

Write back -  

batch data 

Write back batch level data, such as 

predictions or final quality attributes, 

to the data source. 

Write back for batch 

configuration at the batch level 

 

Node hierarchy The SimApi supports a hierarchy of 

nodes, similarly to a file system. Each 

node can contain tags and other 

nodes. The hierarchy makes is easier 

to manage a large number of nodes 

and tags. 

Supported in all places where tags 

are used. 

Supported in 

SIMCA. 

Array tag 

expansion 

An array tag stores multiple values. 

The SimApi expands the array tag to 

many individual tags, one for each 

value in the array. 

Supported where tags are used for 

continuous data. 

 

Multiple data 

sources 

The SimApi can connect to more 

than a single data source, or 

supports multiple instances of itself 

with individual settings and log files 

for each instance.  

Connect to several different data 

sources of the same kind. See 

umetrics.com/kb/multiple-

instances-same-simapi-simca-

online-server  

 

Connection 

resiliency 

If the SimApi becomes disconnected 

from the data source, it will try to 

reestablish the connection. 

The SIMCA-online server doesn't 

have to be restarted to reestablish 

connections to the data source. 

 

Developed in-house The SimApi is developed, provided 

and supported by Sartorius Stedim 

Data Analytics. 

  

3.1 Only Current data is not recommended  
Some SimApis, notably OPC DA, only supports reading current data, and not historical data.  

o build 

the models. 

For SIMCA-online, we recommend a SimApi that supports historical data, but a SimApi with only current data can work, but there are 

issues you have to be aware of. Learn more in the SIMCA-online Technical Guide.  

https://umetrics.com/kb/multiple-instances-same-simapi-simca-online-server
https://umetrics.com/kb/multiple-instances-same-simapi-simca-online-server
https://umetrics.com/kb/multiple-instances-same-simapi-simca-online-server
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 Preparing for a SimApi installation 
This section describes important information that apply to most SimApis. This information can be useful to know to successfully install 

and configure a SimApi. 

4.1 32- or 64-bit SimApis 
There are 32-bit and 64-bit versions of the SimApis available. Which one to use depends on the architecture of the program you want 

to use it with. For example, a 64-bit SIMCA-online server requires a 64-bit SimApi DLL but a 32-bit SIMCA desktop software requires a 

32-bit SimApi DLL. 

4.2 Location for log file and settings 
A SimApi stores its log files in the Program Data folder2 in the following location: 

%programdata%\Umetrics\SimApi, where %programdata% maps to the actual folder on your computer. It defaults to 

C:\ProgramData. 

Each SimApi typically uses its own log file, which similarly to the SIMCA-online server log file will contain more or less data depending 

on a log level setting. This file is useful for troubleshooting. The log file is named <simapi>.log where <simapi> is the SimApi that you 

are installing, for example PIAFSimApi.  Also see the next section for SIMCA-online SimApi instance names. 

This folder also contains the SimApi settings in a XML file named <simapi>.xml.  

Most SimApis have graphical user interfaces that make the settings in the xml file, but for some you make the changes directly in the 

XML file with a text editor, such as Notepad. See the user guide for each SimApi for more information. 

4.2.1 File names when named instances are used with SIMCA-online 13.1 or later 
With SIMCA-online 13.1 or later, each SimApi instance get its own configuration file and log file in order to support multiple instances 

of each SimApi. The names of these files are suffixed by the name of the instance as given on the SimApi tab in the SIMCA-online 

Server Options dialog. The following example shows the naming of these files, where <simapi> needs to be replaced with the SimApi 

name. 

Configuration name given when the instance is added: OmegaServer 

Configuration file name: <simapi>OmegaServer.xml 

Log file name: <simapi>OmegaServer.log 

Note that the generic file <simapi>.log file still is created. This log file contains entries that for technical reasons cannot be directed to 

the log file of the instances. 

Note that SIMCA and Easy Analytics do not support multiple instances, and therefore use the names without instance name as 

described above. 

4.3 Network planning 
You should locate the SIMCA-online server close to the external data source in the network. This ensures a fast connection between 

SIMCA-online and its data source. 

Be aware that networking equipment may interfere with the connection between SIMCA-online and the external data sources; 

firewalls can for example drop connections after a period of inactivity resulting in problems in SIMCA-online where the data source 

becomes disconnected in a SimApi. 

4.4 User accounts and data source permissions 
Data sources typically control access to their data. This is usually done with user names and passwords but IP-address- or DNS-based 

restrictions can also be used (for example PI Trusts in OSIsoft PI).  

The user name and password are provided to the data source in different ways depending on the system: 

• For generic ODBC you can use the ODBC Data Sources Administrator application found on Start in Windows. 

• Some database providers provide their own drivers and tools for their databases. Oracle databases, for example, use the 

Oracle Data Access Components (ODAC). 

• Some SimApis have configuration dialogs that store the encrypted credentials in the SimApi XML configuration file.  

                                                                 
2 This folder is hidden in Windows by default. In order to see it in Windows Explorer you configure File Explorer to show hidden files. 

Note that you still can navigate to a hidden folder by copying and pasting the folder path to File . 
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• OPC uses DCOM as the transport between data source and SimApi. DCOM is configured with the Component Services tool 

(DCOMCNFG.EXE) in Windows, and uses Windows authentication. 

• For the OSIsoft PI SimApi (not the newer AF SimApi), the OSIsoft AboutPI-SDK application (PISDKUtility.exe) is used to set up 

the connection to the PI server. PI also has various security options available in the PI System Management Tools on the PI 

server computer. Read more in the PI AF SimApi User Guide. This guide is helpful even if you use the older OSIsoft PI SimApi. 

4.5 Verifying SimApi connectivity 
When you want to install a SimApi on a computer it can be useful to verify the connectivity from that computer to the data source 

with another tool. Here are some tips on how to do that: 

• Matrikon OPC Explorer for DA or HDA (these are separate tools) can be used to test OPC connectivity, and Matrikon OPC 

Analyzer can be used to diagnose the OPC connectivity issues. Download these free tools from 

https://www.matrikonopc.com/products/opc-desktop-tools/index.aspx 

• OPC Rescue from the  

problems, and repair them instantly with the push of a button. All this can be done without ever having to learn to 

 

• ODBC Data Sources in Windows is used to configure and test generic ODBC. Note that there are two versions of this tool 

on 64-bit Windows: one for 32-bit applications and one for 64-bit3. Use the Test Data Source button at the end of the ODBC 

configuration wizard to verify connectivity to the database. We recommend that you configure your data sources as System 

DSNs. 

• A database specific connection tool from the provider of the database, such as the Oracle Data Access Components. 

• AboutPI-SDK application (PISDKUtility.exe) can be used to test connectivity and to view any error messages that might 

have been logged when SIMCA-online tries to connect to the PI server. This is only used for the older OSIsoft SimApi, not 

PIAF. 

• PI System Management Tools are used on the PI server computer for troubleshooting from that side. For example, to look 

for security issues preventing access from the SIMCA-online server. Learn more on PI system troubleshooting in this 

YouTube video. 

• Excel can be used to obtain data from an ODBC connection and most other systems when a suitable plugin is installed. 

 Installing a SimApi 
Here is how to install a SimApi on a computer: 

1. Read the user guide for the SimApi. It contains specifics for that SimApi that complement the general instructions you are 

reading now. 

2. Install and configure any prerequisites mentioned in the SimApi User Guide (for example Oracle Data Access Compoments 

for the ODBC SimApi if you want to connect to an Oracle database). 

3. Run the setup program to install the SimApi. Install the 64-bit (x64) or the 32-bit (x86) version that matches the software 

you will run it in. 

4. Configure the SimApi in SIMCA-online, SIMCA or Easy Analytics as described in the following sections, and refer to the user 

guide of the SimApi for descriptions of available settings. 

5. Start the SIMCA-online server. Note: when the SimApi is initialized, it will enumerate all tags in the data source. This can 

take time, especially if there are many tags, if the data source is slow, or if the network latency is high. 

6. If the SimApi fails to work as expected, refer to the SimApi log files to help troubleshooting. Increase the log level if needed. 

Refer to the SimApi user guide.  

7. Test the SimApi. For SIMCA-online, you can use File > Extract as described in 6.2. 

5.1 Setting up the SimApi for use in SIMCA or Easy Analytics 
SIMCA or Easy Analytics: 

1. Start the database import in one of  the following ways: 

a. In SIMCA: File > New Regular Project or New Batch Project. If the database import wizard is not opened 

automatically, open it from File > New Spreadsheet > From Database.  

b. In SIMCA: Import Dataset on the Data tab of an open SIMCA project. 

c. In Easy Analytics: Add data from the left side pane, and select Add from database. 

                                                                 
3 In Windows, use Start search to find both the 32- and 64-bit ODBC Data Sources tools. In 64-bit Windows 7 the start menu only lists 

the 64-bit version, but you can start the 32-bit ODBC Data Sources program by launching it manually from the SysWow64-folder, 

typically C:\Windows\SysWOW64. 

https://www.matrikonopc.com/products/opc-desktop-tools/index.aspx
http://www.opcti.com/(S(nl1w4a55gooowiiw33ncgpzf))/ResourceDetails.aspx?id=2305
https://www.youtube.com/watch?v=XOB8U2eIL3E
https://www.youtube.com/watch?v=XOB8U2eIL3E
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2. Click on Add new datasource 

3. Select SimApi as the connection type, click the -button and locate the <simapi>.dll in the installation folder, and click 

Open.  

4. Click  and refer to the individual SimApi User Guide how to make the settings. 

5. Click the Test data source connection to verify that you can connect to the database. 

6. Click OK to complete the configuration. 

7. Refer to the SIMCA help for how to import data. 

5.2 Setting up the SimApi for use in SIMCA-online 
Note: SIMCA-online uses a server license to control which features are available. To be able to use a SimApi you have to have a license 

that permits it. A demo license of SIMCA-online does not allow SimApis to be used. 

-online: 

1. On the server computer, start the SIMCA-online Server Options utility from Start in Windows. Go to the SimApi tab and 

click Add... 

2. Give this instance of the SimApi a name. Use a name that distinguishes it from other data sources, such as the server name 

and type (for example MyPIServer).  
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3. Click the -button to browse to and select the <simapi>.dll located in the installation folder.  

4. Click OK to add the new SimApi and answer Yes to the question about launching the SimApi configuration program to 

make the settings for the SimApi instance. 

5. Refer to the user guide of the specific SimApi for information about the available settings for it. 

 

To configure multiple instance of this SimApi, repeat the above steps and use unique names for each instance. Read more about 

the different log and configuration files for the instances above. 

 Troubleshooting and testing a SimApi installation 
This chapter is about testing and troubleshooting a SimApi installation. 

6.1 Problems caused by not testing with the SIMCA-online service account 
When you are testing access to the external data source, remember that you are logged in as a specific user on the server computer 

(typically your own user account in a Windows domain), but that the SIMCA-online server by default is running as LocalSystem which 

has different access rights compared to your user account. For this reason, it is not uncommon that the above listed tests work fine, 

but that SIMCA-online fails to connect to the data source.  

To solve this issue, access must be granted for the account that is used by the SIMCA-online server service. 

6.2 Testing a SimApi from SIMCA-online 
Here is how to test the SimApi connection from a SIMCA-online client, once the SIMCA-online server has been started successfully 

with the new SimApi loaded. 

Extract tests the SimApi by obtaining data through it using the different modes of data retrieval: current-, historical-, batch- and 

discrete data can be extracted and thus tested. Extract is found on the File tab. 

Repredict  

time range, then the problem is related to the batch node that is specified for the configuration. Repredict is found on the 

Administration tab in the ribbon or in the Project Administration window. 

Find batches found on the Batch node page of the project configuration wizard can like Repredict be used to search for batches in a 

batch node. 

The server log and the SimApi logs are use -level logging in both 

the server log and the SimApi log to get full details. Learn more in http://umetrics.com/kb/making-use-simca-online-server-logging-

finding-problems  

http://umetrics.com/kb/making-use-simca-online-server-logging-finding-problems
http://umetrics.com/kb/making-use-simca-online-server-logging-finding-problems

